
افت نور در فتوشاپ چیست؟

افت نور در فتوشاپ یا Lighting Effect به مجموعهای از تنیها و ابزارهای گفته مشود که برای ایجاد، تغییر
یا تقویت جلوههای نوری در تصاویر و طرحهای گرافی استفاده مشوند. با استفاده از این افتها متوان نورهای

مصنوع، درخشش، پرتوهای نوری، انعاس نور و جلوههای سینمای ایجاد کرد تا تصویر جذابتر و حرفهایتر به
نظر برسد.

در ایجاد حس، عمق و تمرکز بصری دارد. ی س، نور نقش بسیار مهمو ویرایش ع گرافی در دنیای طراح
تصویر ساده با اضافه کردن ی نورپردازی مناسب متواند حالت دراماتی، گرم، مدرن یا حت فانتزی پیدا کند. به

همین دلیل افتهای نوری ی از تنیهای پرکاربرد در طراح پوستر، تبلیغات، تصاویر پرتره، کاور شبههای
اجتماع و آثار دیجیتال محسوب مشوند.

فتوشاپ ابزارهای مختلف برای ساخت افت نور در اختیار کاربران قرار مدهد. از فیلتر Lighting Effects گرفته
تا استفاده از Brush Tool، Layer Styles، Blend Modeها و Layer Mask، روشهای مختلف برای ایجاد نورهای
جهت و میزان پخش شدن نور را تغییر دهد تا نتیجه نهای ،تواند شدت، رنو کنترلشده وجود دارد. طراح م واقع

با فضای تصویر هماهن شود.

کاربرد افتهای نوری در طراح و ادیت تصاویر

افتهای نوری ی از تنیهای پرکاربرد در طراح گرافی و ویرایش تصاویر هستند که برای ایجاد حس، عمق
و جذابیت بصری استفاده مشوند. ی نورپردازی مناسب متواند ی تصویر ساده را به ی اثر حرفهای و

چشمیر تبدیل کند و توجه مخاطب را به بخشهای مهم تصویر هدایت کند.

در فتوشاپ، افتهای نور فقط برای زیباسازی استفاده نمشوند، بله متوانند نقش مهم در انتقال احساس و
را کاملا طراح تواند حالوهوای یو شدت نور م ایجاد فضای خاص در تصویر داشته باشند. انتخاب نوع، رن

تغییر دهد.

مقالات دیزیف را از اینجا دنبال کنید

https://www.adobe.com/products/photoshop.html
https://disiphee.ir/%d8%b1%d8%a7%d9%87%d9%86%d9%85%d8%a7%db%8c-%da%a9%d8%a7%d9%85%d9%84-blend-mode-%d8%af%d8%b1-%d9%81%d8%aa%d9%88%d8%b4%d8%a7%d9%be/
https://disiphee.ir/mag/


ایجاد عمق و حجم در تصاویر

ی از مهمترین کاربردهای افت نور، ایجاد حس سهبعدی و افزایش عمق تصویر است. با اضافه کردن نور و سایه
مناسب، عناصر موجود در تصویر برجستهتر دیده مشوند و فاصله بین بخشهای مختلف بهتر مشخص مشود.

برای مثال، در طراح پوستر یا تصاویر تبلیغات، استفاده از نورهای جهتدار باعث مشود سوژه اصل از پسزمینه
جدا شود و تمرکز بیشتری روی آن ایجاد شود.

ایجاد فضای سینمای در تصاویر

افتهای نوری نقش مهم در ایجاد ظاهر سینمای دارند. نورهای گرم، پرتوهای نوری، درخششها و کنتراستهای
کنترلشده متوانند حس ی صحنه فیلم را به تصویر اضافه کنند.

این تنی در طراح کاور فیلم، پوستر، تصاویر تبلیغات و پروژههای هنری دیجیتال بسیار استفاده مشود.

های گرافیجذابتر کردن طراح

در طراحهای گرافی مانند پوستر، بنر، طراح تامنیل یوتیوب، کاور شبههای اجتماع و تبلیغات دیجیتال، افت
طراح توانند یم تهای رنو اف Glow Effect ،شود. نورهای درخشاننور باعث افزایش جذابیت بصری م

ساده را مدرنتر و حرفهایتر نشان دهند.

مقاله مفید : قلم نوری فتوشاپ چیست? و کاربرد آن

تمرکز روی بخشهای مهم تصویر

با استفاده از نور متوان ناه مخاطب را به قسمت خاص از تصویر هدایت کرد. معمولا طراحان با قرار دادن نور
روی سوژه اصل یا بخش مهم طراح، اولویت بصری ایجاد مکنند.

این تنی در طراح پوستر، تبلیغات محصول و تصاویر پرتره کاربرد زیادی دارد.

https://disiphee.ir/%d9%82%d9%84%d9%85-%d9%86%d9%88%d8%b1%db%8c-%d9%81%d8%aa%d9%88%d8%b4%d8%a7%d9%be/


اصلاح و بهبود نورپردازی عسها

گاه ی عس به دلیل نور نامناسب، تخت یا کمحجم به نظر مرسد. با استفاده از افتهای نوری در فتوشاپ
متوان نورهای جدید ایجاد کرد، قسمتهای تاری را تقویت کرد و حس طبیعتری به تصویر داد.

با این حال، باید توجه داشت که افت نور نباید جایزین نورپردازی واقع شود؛ بله باید برای تمیل و بهبود تصویر
استفاده شود.

استفاده در طراحهای مدرن و دیجیتال

افتهای نوری در سبهای مدرن مانند طراح نئون، سایبرپان، طراح رابط کاربری، پوسترهای دیجیتال و آثار
سهبعدی کاربرد فراوان دارند. ترکیب نورهای رن، درخشش و سایههای نرم باعث ایجاد ظاهر مدرن و جذاب در

این سبها مشود.

انواع افت نور در فتوشاپ

در فتوشاپ روشهای مختلف برای ایجاد جلوههای نوری وجود دارد و هرکدام برای هدف خاص استفاده مشوند.
دارد. برخ موضوع تصویر و نتیجهای که قصد دارید ایجاد کنید بست ،طراح ت نور به سبانتخاب نوع اف

افتها برای طبیعتر کردن نور عس استفاده مشوند و برخ دیر برای ایجاد جلوههای خلاقانه و فانتزی کاربرد
دارند.

(Glow Effect) ت درخشش نوراف

افت Glow ی از رایجترین جلوههای نوری در فتوشاپ است که برای ایجاد حالت درخشان روی سوژهها، متنها و
عناصر گرافی استفاده مشود. این افت باعث مشود ی بخش از تصویر مانند منبع نور به نظر برسد.

از Glow Effect معمولا در طراح لوگو، نوشتههای نئون، پوسترهای تبلیغات و تصاویر دیجیتال استفاده مشود.
کنترل میزان درخشش، رن نور و شدت پخش شدن آن اهمیت زیادی دارد تا نتیجه طبیع و حرفهای باشد.

(Light Rays) ت پرتو نوراف

افت پرتو نور برای ایجاد خطوط یا شعاعهای نوری استفاده مشود که معمولا از ی منبع نور مشخص در تصویر



منتشر مشوند. این نوع افت متواند حس حضور نور خورشید، نور چراغ یا ی منبع نور قدرتمند را ایجاد کند.

پرتوهای نور در طراحهای سینمای، تصاویر طبیعت، پوسترها و آثار فانتزی کاربرد زیادی دارند و باعث ایجاد عمق
و فضای داستان در تصویر مشوند.

(Lens Flare) ت نور لنزاف

Lens Flare شبیه انعاس نوری است که هنام برخورد نور شدید با لنز دوربین ایجاد مشود. این افت متواند

حس عاس واقع و سینمای به تصاویر اضافه کند.

استفاده از Lens Flare باید با دقت انجام شود؛ زیرا استفاده بیش از حد از آن ممن است باعث شود تصویر
غیرطبیع یا آماتور به نظر برسد.

(Neon Light Effect) ت نور نئوناف

افت نور نئون برای ایجاد نورهای رن و درخشان با ظاهر مدرن استفاده مشود. این سب بیشتر در طراحهای
دیجیتال، پوسترهای تنولوژی، آثار سایبرپان و طراحهای مرتبط با فضای شبانه دیده مشود.

ترکیب رنهای درخشان مانند آب، صورت، بنفش و سبز در کنار پسزمینههای تاری، باعث ایجاد جلوهای جذاب
و امروزی مشود.

(Cinematic Lighting) ت نور سینمایاف

افت نور سینمای با هدف ایجاد حس و فضای مشابه تصاویر فیلمها استفاده مشود. در این سب معمولا از
ترکیب نورهای گرم و سرد، سایههای عمیق و کنتراست بالا برای ایجاد حس دراماتی استفاده مشود.

این نوع نورپردازی در طراح پوستر فیلم، کاورهای حرفهای، تصاویر پرتره و تبلیغات کاربرد زیادی دارد.

(Color Light Effect) ت نور رناف

نارنج ،شود. اضافه کردن نورهای قرمز، آبتصویر استفاده م برای تغییر فضای کل در این روش از نورهای رن
یا بنفش متواند احساس متفاوت به تصویر بدهد.



برای مثال، نورهای گرم معمولا حس صمیمیت و انرژی ایجاد مکنند، در حال که نورهای سرد متوانند حس
مدرن، آرام یا تنولوژی ایجاد کنند.

(Volumetric Light) ت نور حجماف

نور حجم حالت ایجاد مکند که انار نور در فضای تصویر پخش شده و در محیط قابل مشاهده است. نمونه
طبیع آن، مشاهده پرتوهای خورشید در ی اتاق تاری یا میان مه است.

این افت برای ایجاد عمق، واقعگرای و فضای سینمای در تصاویر بسیار کاربردی است.

(Soft Light) ت نور نرماف

تبلیغات اسشود. این نوع نور بیشتر در روتوش پرتره، عاستفاده م ملایم و طبیع برای ایجاد روشنای Soft Light

و اصلاح نور تصاویر کاربرد دارد.

برخلاف نورهای شدید، نور نرم باعث ایجاد تغییرات ظریف مشود و کم مکند تصویر طبیعتر و حرفهایتر به
نظر برسد.



آمادهسازی تصویر قبل از ایجاد افت نور

قبل از ایجاد افت نور در فتوشاپ، باید تصویر را برای نورپردازی آماده کنید. کیفیت عس، نور اولیه و رنهای
دارند؛ بنابراین بهتر است از تصاویر با رزولوشن مناسب و جزئیات کاف تصویر تأثیر زیادی روی نتیجه نهای

استفاده شود.

Levels یا Curves مانند کنید و در صورت نیاز با ابزارهای قبل از شروع، نور و کنتراست تصویر را بررس
اصلاحات اولیه را انجام دهید. همچنین بهتر است ی کپ از لایه اصل ایجاد کنید تا بتوانید افت نور را به صورت

غیرمخرب و قابل کنترل اعمال کنید.

در مرحله بعد، جهت و رن نور را مشخص کنید. نور باید با فضای تصویر هماهن باشد و با سایهها و عناصر
موجود در عس تضاد نداشته باشد. انتخاب درست منبع نور باعث مشود افت نهای طبیعتر و حرفهایتر دیده

شود.

https://disiphee.ir/wp-content/uploads/2024/03/types-of-light-effects-photoshop.jpg
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ایجاد نور مصنوع با Brush Tool در فتوشاپ

ی از سادهترین و کاربردیترین روشها برای ساخت افت نور در فتوشاپ، استفاده از Brush Tool است. با این
روش متوان نورهای نرم، هالههای درخشان، نقاط نوران و جلوههای سفارش ایجاد کرد و کنترل بیشتری روی محل

و شدت نور داشت.

(Soft Round Brush) براش نرم را با ی Brush Tool لایه جدید ایجاد کنید و ابزار برای شروع، بهتر است ی
انتخاب کنید. سپس با انتخاب رن مناسب، مانند سفید، زرد، آب یا هر رن متناسب با تصویر، متوانید نقاط نور

را روی بخشهای مورد نظر اضافه کنید.

برای طبیعتر شدن نور، بهتر است از Opacity پایین استفاده کنید و نور را به صورت مرحلهای بسازید. همچنین
تغییر حالت ترکیب لایه به گزینههای مانند Screen یا Overlay متواند باعث شود نور بهتر با تصویر ترکیب شود.

میزان اندازه براش نیز اهمیت زیادی دارد. براشهای بزرگ برای ایجاد هالههای نور و روشنای کل مناسب هستند،
در حال که براشهای کوچتر برای ایجاد نقاط درخشان و جزئیات نوری استفاده مشوند.

https://disiphee.ir/wp-content/uploads/2024/03/photoshop-brush-tool-light-effect.jpg


(Glow Effect) ت درخشش نورساخت اف

از پرکاربردترین جلوههای نوری در فتوشاپ است که برای ایجاد حالت درخشش، روشنای ی Glow Effect تاف
نرم و حس نوران در تصاویر استفاده مشود. این افت متواند روی متن، لوگو، سوژههای تصویر یا بخشهای

خاص از طراح اعمال شود و باعث جذابتر شدن نتیجه نهای شود.

برای ساخت Glow Effect معمولا ابتدا ی لایه جداگانه ایجاد مشود تا افت نور بدون آسیب به تصویر اصل قابل
روشن انتخاب شده و در بخش مورد نظر ی رن ،Brush Tool مانند کنترل باشد. سپس با استفاده از ابزارهای

هاله نور ایجاد مشود.

برای نرم کردن نور و حالتهای ترکیب Gaussian Blur مانند توان از گزینههایتر شدن درخشش، مبرای طبیع
لایه مانند Screen یا Linear Dodge (Add) برای ترکیب بهتر نور با تصویر استفاده کرد. میزان شفافیت لایه نیز باید

تنظیم شود تا نور بیش از حد مصنوع دیده نشود.

ی از نات مهم در ایجاد Glow Effect، هماهن رن و شدت نور با فضای تصویر است. برای مثال، نورهای
سفید و گرم معمولا برای جلوههای طبیع مناسب هستند، در حال که رنهای نئون مانند آب و بنفش بیشتر در

طراحهای مدرن و دیجیتال استفاده مشوند.



ایجاد پرتوهای نور (Light Rays) در فتوشاپ

از جلوههای جذاب در فتوشاپ است که برای شبیهسازی تابش نور از ی یا پرتوهای نور ی Light Rays تاف
منبع مشخص استفاده مشود. این افت معمولا برای ایجاد حس سینمای، عمق بیشتر و فضای دراماتی در

تصاویر کاربرد دارد؛ مانند نور خورشید که از میان پنجره، درختان یا مه عبور مکند.

برای ساخت پرتوهای نور، معمولا ابتدا ی لایه جداگانه ایجاد مشود تا نور به صورت مستقل کنترل شود. سپس با
استفاده از ابزارهای مانند Brush Tool یا تنیهای مربوط به فیلترها، بخشهای روشن تصویر ایجاد شده و با

Gaussian Blur نرمتر مشوند تا حالت طبیعتری پیدا کنند.

برای واقعتر شدن پرتوهای نور، باید جهت تابش با منبع نور موجود در تصویر هماهن باشد. همچنین تنظیم
Opacity و استفاده از حالتهای ترکیب مانند Screen کم مکند نور بهتر با پسزمینه ترکیب شود و حالت

مصنوع پیدا نند.

پرتوهای نور معمولا در تصاویر طبیعت، پوسترهای سینمای، طراحهای فانتزی و آثار دیجیتال استفاده مشوند.
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ترکیب این افت با مه، ذرات نور یا سایههای مناسب متواند حس عمق و فضای حرفهایتری به تصویر بدهد.

ساخت افت نور سینمای روی تصاویر

نور سینمای (Cinematic Lighting) به سب خاص از نورپردازی گفته مشود که در فیلمهای حرفهای استفاده
مشود و حس عمق، درام و احساس قوی ایجاد مکند.

های نور سینمایویژگ

و تاری کنتراست بالا: تفاوت واضح بین روشنای
رنبندی محدود: معمولا از دو رن ممل (مثل نارنج و آب) استفاده مشود

ونیتمانند: حاشیههای تاریشده دور تصویر
نور خلف: جدا شدن سوژه از پسزمینه با نور پشت
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مراحل ساخت نور سینمای

Radial Gradient از حاشیه به مرکز Gradient Tool لایه جدید بسازید، با ی :Vignette گام ۱ – اضافه کردن
سیاه بشید، Blend Mode را Multiply کنید.

گام ۲ – رنبندی سینمای: یGradient Map  از نارنج به آب اعمال کنید و Opacity را پایین بیاورید.

گام ۳ – افزایش کنتراست: با Curves یS-Curve  ملایم اعمال کنید.

گام ۴ – نور خلف: با Brush Tool ی هاله روشن پشت سوژه رسم کنید.

گام ۵ – جزئیات نوری: با Dodge Tool نقاط کلیدی صورت یا سوژه را کم روشنتر کنید.

پریستهای سینمای معروف

Teal and Orange: آب‐سبز و نارنج – پرکاربردترین ترکیب در سینما

Day for Night: شبیهسازی شب با عس روز

Film Noir: سیاه و سفید با کنتراست شدید

Golden Hour: نور طلای غروب آفتاب



استفاده از Blend Modeها برای طبیعتر شدن نور

Blend Modes (حالتهای ترکیب) قلب تپنده هر افت نوری در فتوشاپ هستند. درک صحیح آنها تفاوت بین

افت مصنوع و واقعگرایانه است.

Blend Modeهای اصل برای افت نور

Screen

بهترین حالت برای نور: رنهای تیره حذف مشوند و فقط روشنای باق مماند. ایدهآل برای Glow، Lens Flare و
Light Rays. هیچوقت تصویر را از Screen تیرهتر نمکند.

(Add (Linear Dodge

مشابه Screen اما قویتر. برای نور بسیار شدید و درخشان مناسب است. مراقب باشید که زیاد استفاده نشود چون
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ممن است تصویر بیش از حد روشن شود.

Overlay

کنتراست را افزایش مدهد و هم نور هم سایه را تقویت مکند. برای افزودن بافت نوری به تصویر عال است.

Soft Light

ملایمتر از Overlay. برای نور طبیع و ظریف مناسب است. تصویر را گرمتر یا سردتر مکند بدون اینه بیش از
حد تأثیر بذارد.

Hard Light

تأثیر قویتری نسبت به Soft Light دارد. برای ایجاد کنتراست شدید بین نور و سایه مناسب است.

Color Dodge

بخشهای روشن تصویر را بیشتر روشن مکند. برای ایجاد نور متمرکز و درخشان استفاده مشود.

Blend Mode جدول راهنمای انتخاب

نور ملایم و طبیعSoft Light : یا Overlay با Opacity پایین
Add یا Screen :گلو و درخشش

Hard Light :نور شدید و سینمای
Hue یا Color :نور رن

Multiply :کردن سایه تاری

نته: آزمایش با Blend Modes مختلف و تغییر Opacity بهترین راه برای یافتن ترکیب ایدهآل است.



نقش Layer Mask در کنترل افتهای نوری

Layer Mask ابزاری است که به شما اجازه مدهد بخشهای از ی لایه را پنهان یا نمایان کنید بدون اینه

پیسلهای آن را حذف کنید. در افتهای نوری این ابزار حیات است.

Layer Mask اصول کار با

در Layer Mask، رن سفید به معنای نمایش کامل است (نور دیده مشود) و رن سیاه به معنای پنهان شدن کامل
است (نور دیده نمشود). خاکستریهای مختلف شفافیتهای بین این دو را ایجاد مکنند.

کاربردهای Layer Mask در افت نور

محدود کردن نور به ی ناحیه خاص (مثلا فقط روی صورت سوژه)
ایجاد گذار نرم و تدریج بین نور و عدم نور

جداسازی افت نور از پسزمینه
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Brush Tool رسم مسیر دقیق نور با

Layer Mask روش اضافه کردن

۱. لایه افت نور را انتخاب کنید.

۲. در پایین پنل Layers روی آیون Layer Mask کلی کنید.

۳. با Brush Tool سیاه، بخشهای که نمخواهید نور ببینید را رسم کنید.

۴. با Brush Tool سفید، بخشهای که مخواهید نور ببینید را بازگردانید.

Luminosity Mask :ترفند

Luminosity Mask ی ماس پیشرفته است که بر اساس روشنای خود تصویر ساخته مشود. برای ساخت آن:

Layer را انتخاب کنید و از این انتخاب به عنوان Midtones یا Highlights ،بروید Select > Color Range به
Mask استفاده کنید.

� نته: برای گذار نرمتر در Layer Mask، Feather را از گزینههای Select > Modify اعمال کنید.

تنظیم رن و شدت نور برای نتیجه حرفهای

رن نور به اندازه خود نور اهمیت دارد. درک دمای رن و نحوه تأثیر آن بر احساسات بیننده، کلید ساخت
افتهای نوری حرفهای است.

دمای رن نور

نور سرد (آب/سبز ۱۰۰۰۰K‐۵۰۰۰): حس مدرن، سرد، فضای سایبری
نور خنث (سفید ۵۰۰۰K‐۴۰۰۰): طبیع، ساده، حرفهای

حس گرما، خانه، غروب، رمانتی :(۴۰۰۰K‐۲۰۰۰ زرد/نارنج) نور گرم



ابزارهای تنظیم رن نور

Hue/Saturation

رن توانید کل لایه را به یفعال م Colorize استفاده کنید. با ت نور و کنترل شدت رناف کل برای تغییر رن
واحد تبدیل کنید.

Color Balance

و نورها را نارنج توانید سایهها را آبمناسب است. م Highlights و Shadows، Midtones برای تنظیم جداگانه
کنید تا حس سینمای ایجاد شود.

Curves

قدرتمندترین ابزار برای تنظیم رن و کنتراست. با کانالهای R، G، B به صورت جداگانه رنبندی دقیق ایجاد کنید.
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Selective Color

برای تنظیم دقیق رنهای خاص. متوانید فقط رنهای زرد را بدون تأثیر بر رنهای دیر تغییر دهید.

کنترل شدت نور

شدت نور را با Opacity لایه تنظیم کنید. برای شدتهای بیشتر از چند لایه مشابه استفاده کنید. Curves در کانال
RGB نیز برای کنترل روشنای کل مؤثر است.

� نته: در طبیعت، نور سایههای با رن ممل ایجاد مکند. مثلا نور نارنج خورشید، سایههای آب‐بنفش ایجاد
مکند. این اصل را در افتهایتان رعایت کنید.

ترکیب افت نور با سایه برای ایجاد عمق

نور بدون سایه وجود ندارد. ترکیب صحیح نور و سایه عمق بصری ایجاد مکند و تصویر را واقعگرایانهتر منماید.

(Chiaroscuro) یارواصل چابروس

و تاری شود، بر تضاد شدید بین روشنایهای رمبراندت و کاراواجو دیده مکه در نقاش هنری ایتالیای نیاین ت
استوار است. در فتوشاپ متوان این سب را با ترکیب Dodge و Burn و Curves شبیهسازی کرد.

روش ساخت سایه طبیع

۱. ی لایه جدید با Fill Mode Multiply بسازید.

۲. با Brush Tool سیاه و Opacity پایین، سایهها را به آرام رسم کنید.

۳. مطمئن شوید جهت سایه با جهت نور مطابقت دارد.

.(Sharp) باشند نه تیز (Soft) ۴. لبههای سایه باید نرم



Inner Shadow و Drop Shadow

آن باید با جهت نور اصل Angle .استفاده کنید Layer Style > Drop Shadow توانید ازبرای اشیای سهبعدی م
صحنه هماهن باشد.

Burn و Dodge نیت

Dodge Tool (O) نقاط روشن را روشنتر مکند و Burn Tool تاریها را تاریتر. با این دو ابزار متوانید

جزئیات نوری و سایهای روی سطح اشیا اضافه کنید.

Range: Shadows برای تأثیر بر تاریها

Range: Midtones برای تأثیر بر میانهها

Range: Highlights برای تأثیر بر روشنایها

� نته: یDodge  و Burn Layer غیرمخرب بسازید: ی لایه خال با Fill Mode Overlay بسازید و با برس سفید
و سیاه روشنای و سایه رسم کنید.

ساخت افت نور طلای و گرم در فتوشاپ

نور طلای (Golden Light) شاید محبوبترین افت نوری باشد که در عاس پرتره، تبلیغات و طراح لاکچری
بسیار استفاده مشود.

نور طلای پالت رن

FFC200# یا FFD700# :اصل طلای
FF8C00# :گرم نارنج

FFBF00# :آمبر
E6C87A# :بژ طلای

مرحله ۱: لایه پایه گرم

Soft Light را Blend Mode .اضافه کنید (FF7518#) گرم نارنج با رن Solid Color Adjustment Layer ی



و Opacity را ۲۰‐۳۰٪ کنید.

موضع مرحله ۲: نور طلای

Blend .شیدرا در نقطه منبع نور ب (FFD700#) طلای بزرگ و نرم، رن Brush Tool لایه جدید بسازید. با ی
Mode را Screen و Opacity را ۶۰‐۸۰٪ کنید.

Hue/Saturation :۳ مرحله

یHue/Saturation Adjustment Layer  اضافه کنید. رنهای زرد و قرمز را کمSaturate  کنید (+۱۰ تا
.(۲۰+

Color Balance :۴ مرحله

در Highlights: به سمت Yellow و Red ببرید. در Shadows: کم به سمت Blue ببرید تا کنتراست رن ایجاد
شود.

Lens Flare مرحله ۵: افزودن

برای واقعگرای بیشتر، یLens Flare  در مان منبع نور اضافه کنید (Filter > Render > Lens Flare) و آن را در
ی لایه جداگانه قرار دهید.

بهترین پایه برای نور طلای (ساعت قبل از غروب ساعت بعد از طلوع و ی ی) Golden Hour سهایته: عن �
هستند.

ساخت افت نور نئون در فتوشاپ

نور نئون ی از ترندیترین افتهای طراح است که در فضای Cyberpunk، موسیق الترونی و طراح مدرن
شهری بسیار دیده مشود.



پالت رن نئون

FF007F# یا FF00FF# :نئون صورت
00BFFF# :تریال آب

39FF14# :سبز نئون
BF00FF# :بنفش نئون

FFFF00# :زرد نئون

مراحل ساخت نور نئون

گام ۱: متن یا شل دلخواه را در فتوشاپ بسازید.

گام ۲: رن متن/شل را به رن سفید یا رن نئون انتخاب تنظیم کنید.

گام ۳: ی لایه کپ بسازید و Gaussian Blur با radius 3-5 پیسل اعمال کنید. Blend Mode را Screen کنید.

گام ۴: مجدداً کپ بسازید و Gaussian Blur با radius 8-12 پیسل اعمال کنید. Blend Mode را Screen کنید.

گام ۵: کپ سوم با Gaussian Blur 20-30 پیسل برای هاله بیرونBlend Mode . را Screen کنید.

گام ۶: پسزمینه را تیره یا کاملا سیاه کنید تا نئون برجستهتر دیده شود.

اضافه کنید تا سایه رن Blend Mode Multiply مل نئون وم با رن Solid Color Adjustment لایه گام ۷: ی
ایجاد شود.

افزودن بازتاب نئون

برای واقعگرای بیشتر، ی بازتاب کمرن از شل نئون را زیر آن قرار دهید. برای اینار لایه اصل را کپ کرده، به
صورت عمودی Flip کنید، Opacity را کم کنید و Gaussian Blur بیشتری اعمال کنید.

� نته: زمینه سیاه یا خیل تیره بهترین پسزمینه برای نور نئون است. رن نئون روی زمینه روشن تأثیر خود را از
دست مدهد.



Lighting Effect ام ایجاد۱۷. اشتباهات رایج هن

بسیاری از طراحان، به خصوص در ابتدای کار، اشتباهات رایج مرتب مشوند که نتیجه نهای را ضعیف مکند.

اشتباه ۱: نادیده گرفتن جهت نور

جهت نور باید در تمام عناصر تصویر یسان باشد. اگر نور از سمت چپ مآید، سایهها باید در سمت راست باشند.
عدم توجه به این اصل، تصویر را غیرواقع مکند.

Glow اشتباه ۲: استفاده بیش از حد از

گلو زیاد تصویر را مصنوع و آماتور نشان مدهد. اصل کمتر بیشتر است (Less is More) را فراموش ننید.
Opacity پایین و هالههای کوچتر نتیجه بهتری مدهند.

اشتباه ۳: کار روی لایه اصل

همیشه روی کپ لایه یا Smart Object کار کنید. تغییر مستقیم لایه اصل ی اشتباه جبرانناپذیر است.

اشتباه Blend Mode :۴ نامناسب

انتخاب Blend Mode اشتباه متواند نتیجه را کاملا خراب کند. هر افت نوری Blend Mode خاص خود را دارد.
قبل از قضاوت، چند حالت مختلف را امتحان کنید.

نور و سایه ناهماهن اشتباه ۵: رن

اگر نور گرم است، سایه باید سرد باشد و برعس. نادیده گرفتن این قانون طبیع، رنبندی تصویر را نامطلوب
مکند.

Layer Mask اشتباه ۶: فراموش کردن

Layer Mask گیرد. همیشهکنترل دقیق را از شما م ،Layer Mask ت نور به کل تصویر بدون استفاده ازاعمال اف
بسازید و نور را به نقاط دلخواه محدود کنید.



اشتباه ۷: رزولوشن پایین

کار روی تصاویر با رزولوشن پایین باعث مشود افت نور درشت و زشت دیده شود. همیشه با رزولوشن مناسب
کار کنید.

نات حرفهای برای طبیعتر شدن افت نور

طبیع شدن افت نور بیشتر از اینه به تعداد ابزارها یا فیلترهای استفادهشده بست داشته باشد، به هماهن نور با
فضای تصویر مربوط است. ی نور حرفهای باید طوری روی تصویر قرار بیرد که مخاطب احساس کند بخش از

همان صحنه بوده است.

برای رسیدن به نتیجه بهتر، به جهت نور، شدت روشنای و ارتباط آن با سایهها توجه کنید. اضافه کردن نورهای زیاد
یا استفاده بیش از حد از درخششها معمولا باعث مشود تصویر غیرواقع و آماتور به نظر برسد.

:ته مهم در ایجاد نور طبیعچند ن
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نور را همیشه با منبع نور موجود در تصویر هماهن کنید.
از چند لایه نور با شدت کم به جای ی افت شدید استفاده کنید.

رن نور را با فضای کل تصویر هماهن انتخاب کنید.
برای کنترل بهتر، افتها را روی لایههای جداگانه ایجاد کنید.

بعد از اعمال نور، تصویر را در اندازه واقع بررس کنید تا شدت افت بیش از حد نباشد.

ی افت نور خوب باید حس و فضای تصویر را تقویت کند، نه اینه خودش به عنصر اصل تصویر تبدیل شود.

گرفتن از تصویر نهای بهترین روش ذخیره و خروج

بعد از پایان طراح افت نور، انتخاب فرمت مناسب برای خروج گرفتن اهمیت زیادی دارد. نوع خروج باید بر
اساس کاربرد نهای تصویر انتخاب شود؛ زیرا کیفیت، حجم فایل و قابلیت ویرایش در هر فرمت متفاوت است.

برای ادامه ویرایش در فتوشاپ، بهتر است فایل اصل را با فرمت PSD ذخیره کنید تا لایهها، ماسها و تنظیمات
افتها حفظ شوند.

برای انتشار در وبسایت یا شبههای اجتماع، فرمتهای مانند JPEG یا PNG گزینههای مناسبتری هستند.
تصاویر دارای پسزمینه شفاف بهتر است با فرمت PNG ذخیره شوند، در حال که JPEG معمولا برای کاهش حجم

تصاویر مناسب است.

قبل از خروج نهای بهتر است:

وضوح تصویر را بررس کنید.
رنها را در حالت مناسب خروج بیرید.

شدت نور را در اندازه نهای تصویر کنترل کنید.

ذخیره درست فایل باعث مشود کیفیت افت نور حفظ شود و تصویر در پلتفرمهای مختلف ظاهر مناسب داشته
باشد.
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جمعبندی

تهای نوری در فتوشاپ دنیایهای پیشرفته را با هم مرور کردیم. افنیت نور تا تاف در این مقاله جامع، از مبان
بپایان از امانات خلاقانه دارند که با تمرین و آزمایش متوانید به تسلط کامل در آنها برسید.

نات کلیدی که باید به خاطر بسپارید

(Non-Destructive Editing) کار کنید Adjustment Layer و Smart Object همیشه با
Blend Mode مناسب، قلب هر افت نوری است

Layer Mask کنترل دقیق را ممن مکند

نور و سایه همیشه با هم کار مکنند
از Opacity پایین و چند لایه به جای ی لایه پر اثر استفاده کنید

جهت نور در تمام تصویر باید یسان باشد
رن نور و دمای رن باید با حال و هوای تصویر هماهن باشد

سوالات متداول

افت نور در فتوشاپ چیست؟ 

افت نور در فتوشاپ مجموعهای از تنیها برای ایجاد یا تقویت جلوههای نوری در تصاویر است. با استفاده از
این افتها متوان نورهای مصنوع، درخشش، پرتو نور و جلوههای سینمای ایجاد کرد.

چونه در فتوشاپ افت نور ایجاد کنیم؟ 

Layer ها وLighting Effects، Blend Mode فیلتر ،Brush Tool مانند توان از ابزارهایت نور مبرای ایجاد اف
Mask استفاده کرد. معمولا بهترین نتیجه با ایجاد نور روی لایه جداگانه و تنظیم شدت آن به دست مآید.

بهترین ابزار برای ساخت Lighting Effect کدام است؟ 

Brush Tool ،برای ایجاد نورپردازی کل Lighting Effects دارد. فیلتر ت مورد نظر بستابزار مناسب به نوع اف
برای ساخت نورهای سفارش و Layer Mask برای کنترل دقیق نور از کاربردیترین ابزارها در فتوشاپ هستند.



چونه نور طبیع در فتوشاپ بسازیم؟ 

برای ساخت نور طبیع باید جهت نور، رن، شدت روشنای و سایههای تصویر را در نظر گرفت. استفاده از
لایههای جداگانه، Blend Mode مناسب و کاهش شدت افت باعث مشود نور واقعتر به نظر برسد.

تفاوت Glow Effect و Lighting Effect چیست؟ 

Lighting Effect شود، امابخش خاص استفاده م بیشتر برای ایجاد درخشش و هاله نور روی ی Glow Effect

معمولا برای شبیهسازی نورپردازی کل و تغییر فضای تصویر کاربرد دارد. به عبارت دیر، Glow بیشتر روی
درخشش تمرکز دارد و Lighting Effect روی ایجاد منبع نور.

چونه پرتو نور در فتوشاپ ایجاد کنیم؟ 

های ترکیب لایه استفاده کرد. ایجاد ینیفیلترهای فتوشاپ و ت ،Brush Tool توان ازبرای ساخت پرتو نور م
لایه جدا، نرم کردن نور با Blur و تنظیم Blend Mode باعث طبیعتر شدن پرتوها مشود.

چرا افت نور در فتوشاپ مصنوع به نظر مرسد؟ 

معمولا استفاده بیش از حد از شدت نور، انتخاب رن نامناسب، هماهن نبودن جهت نور با تصویر و نادیده گرفتن
سایهها باعث مشود افت نهای مصنوع دیده شود.
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